
Amazon Minisite MEGAProfits 

1. Introduction 

 Who Is Lisa Gergets? 

 40+ year old, married, mom of two who is the sole breadwinner of the family. 

 Started my IM journey handcrafting fingerless gloves from recycled wool sweaters and 

marketing them on Facebook and Twitter. 

 “Discovered” internet marketing in March 2009. 

 Quit my full-time, $55K+ year job to become a full-time internet marketer in May 2010. 

 Doubled my income in 2011. 2012 was even better! 

 I Am Like Many of You 

 No college education (BARELY made it through high school!) 

 I worried about money just like you. 

 I wanted nice things for my family and myself, just like you. 

 Most of all – I wanted FREEDOM! Financial freedom, freedom from worry, freedom to travel, 

freedom to raise my kids… 

IT’S ALL ABOUT THE FREEDOM! 

2. The Site Seller Mindset 

 Mindset is Key 

 If you’ve been promoting sites for any length of time, you’ll see that selling them requires a 

completely different mindset. 

 Shifting this mindset can be difficult at first – keep at it! 

 Start seeing things from a site seller’s point of view rather than that of a site promoter. 

 Soon, you’ll see opportunities everywhere! 

 “It’s Not About You.” 

 Your internet marketing site-selling career will go much more smoothly if you internalize this 

phrase: “It’s not about you.” 



 It’s not about what you like, what you don’t like, or what interests you. 

 YOUR preferences have no bearing in site selling. 

 What’s important in site selling is niche popularity, profitability, and perception. 

3. Finding Great Niches! 

 Evergreen, Evergreen, Evergreen 

 Just starting out, with no list? Select the most popular, evergreen niches. 

a. WAIT! What’s “evergreen”? An evergreen niche is one that is always popular – one that 

never goes out of style. Think babies, kids, dogs and other pets, electronics, health, 

fitness, recreation, hobbies, etc. 

 Remember, you won’t be promoting these sites – you’re selling them. So try to appeal to the 

widest audience possible by choosing evergreen niches as often as you can when starting out. 

 Spectacular Niche-Finding Ideas 

 Advertising circulars – billion-dollar companies have already done the market research FOR you! 

 Amazon.com is absolutely FULL of niche ideas. 

 Look around you – what do you want or need? Do you think a lot of other people want or need 

the same types of things? If so, it’s probably a great niche idea! 

4. Quick & Easy Keyword Research 

 Do NOT Overthink This! 

 Google AdWords Keyword Tool - Exact searches over 1000, broad searches under 150,000 or so l 

 PR4 or under on first page Google results 

 Amazon.com 

 Dynadot.com, Namecheap or any reputable domain registar (I do not recommend GoDaddy or 

1and1) 

 Notebook or text doc to record ideas – you’ll get a LOT of them! 

 There’s no need to invest in expensive, overly-complicated keyword research tools that give you 

TOO much information. 

 My Keyword Phrase Parameters 

 Remember, these are only a guideline of what works for me. YMMV 



 Exact searches over 1000, broad searches under 150,000 using Google Adwords Keyword Tool 

 PR4 or under on first -page Google results (first ten or so results returned for your keyword 

phrase in Google) 

 Download and install SEO Quake in the Chrome browser to find the PR of the first-page results – 

I’ve found this to be the easiest to use. 

 Again – no overthinking this task! Quick & easy! 

 TYPES of Sites 

 Looking at the TYPES of sites that are returned for a keyword phrase can give you a clue as to 

what people are looking for when they look up that particular phrase. 

 EXAMPLE: if your keyword phrase is “knitted socks” and  you see it has great search numbers, go 

do a Google search. You’ll find that people looking up knitted socks are NOT looking for knitted 

socks to buy…they are looking for knitted sock patterns… 

 Be Aware: 

 Don’t use trademarked names in any domain. Your site buyer could have the entire site taken 

away from them by the trademark holder at any time with absolutely no recourse.  

 Make sure your keyword phrase is not regional – I once used the keyword phrase “cornhole 

game”, which is a popular summertime game in the USA. My UK buyers, among others, had no 

idea what it was, only knew it didn’t sound good.  

5. What To Do With Your New Domain 

 A .com Domain Every Time! 

 In your domain registrar, simply add a “generic” work to the end of your keyword phrase. 

 Examples include online, shop, store, tips, guide, info, etc. Make it generic enough that a 

search engine spider won’t detect it as part of the keyword phrase. 

 This will not affect the SEO of the site. 

 Example: if your keyword phrase is water filters, and waterfilters.com is taken, try 

waterfiltersonline.com, waterfiltersguide.com, waterfiltersinfo.com, etc.  

 Set It Up! 

 After you’ve purchased your domains: 

 Set the nameservers to point to your hosting account DNS 

 Shared Hosting Account: add the domain as an add-on domain . 



 Reseller Hosting Account: set up an account for the domain. 

 I highly recommend Hostgator hosting. It is what I use exclusively for all of my websites. 

 Don’t do anything else with the domain yet. 

6. Choosing Header Images 

 About Outsourcing 

 Your header is the first thing a potential buyer sees. It needs to look clean and professional. 

 If you don’t have design skills, this is one thing you can outsource relatively cheaply at places like 

Fiverr.com. 

 You don’t need to know Photoshop or GIMP to be able to create a great header. I’ll show you 

how in the next video. 

 Image Licensing  

 IMPORTANT! 

 You can get yourself in a boatload of trouble by not looking at the licensing for the images you 

choose to use. You can NOT simply take any image off the internet and use it in your website. 

 Your image must have a commercial license specifically stating it can be used in a web template. 

 “Royalty-Free” does not mean you automatically have a commercial license to use the image. 

 Image Licensing cont.  

 Some free image sites where you have license to use the images on web templates: 

a. Morguefile.com 

b. Free section of Dreamstime.com 

c. Stock.XCHNG (http://www.sxc.hu/) 

 License must be specific, like this: 

 

http://secure.hostgator.com/~affiliat/cgi-bin/affiliates/clickthru.cgi?id=antigurugirl
http://secure.hostgator.com/~affiliat/cgi-bin/affiliates/clickthru.cgi?id=antigurugirl
http://www.sxc.hu/
http://www.sxc.hu/


 Choosing Images 

 It’s easiest to start with images with a totally white background. 

 Since we will be showcasing Amazon.com products on our sites, we can use product images 

from Amazon.com. 

 Maximum of two images per website header – a clean look is what we’re after. 

 If you can’t find appropriate images to use, consider a graphic background for your header (but 

make sure you still have license rights). 

 Resizing Images 

 Remember – your image, after any necessary cropping, will need to be resized to the height of 

your header, or it won’t fit! 

 If you have MS Office, you probably have Microsoft Office Picture Manager somewhere on your 

computer. Do a search and look for it, as it’s a very easy solution. 

 http://www.online-image-editor.com/ is also an excellent free solution to crop and resize 

images. 

7. Creating A Website Header 

 Download XHeader  http://xheader.com 

 Yes, you’ll have to give your email address to get access to XHeader, but it’s worth it.  

 I recommend you do NOT purchase the additional header backgrounds you will be offered each 

time you open and close XHeader. You really don’t need them.   

 Choose your header size. I prefer 800-900 by 175 pixels. 

 Add images 

 Create a “container” for the header text and save the header. 

 Go to http://bannerfans.com or http://picmonkey.com, upload your header, and add your 

header text (XHeader is too limited in their font choices, in my opinion.) 

 Save your completed header for use in your template. 

8. Choosing a Template 

 Why Do I Use Artisteer? 

http://www.online-image-editor.com/
http://www.online-image-editor.com/
http://xheader.com/
http://bannerfans.com/
http://picmonkey.com/


 It’s really pretty simple: I use Artisteer because it’s relatively inexpensive, easy-to-use, and has 

limitless possibilities. I not only use it for my Amazon Minisites, but I also use it to create sites 

for offline businesses. 

 You don’t HAVE to use Artisteer. If you have a theme you’re particular good at customizing, then 

go for it! Just remember that we’ll be showcasing Amazon products, so keep that in mind when 

choosing a theme. 

 A Good Theme Has:    

 A clean look. 

 Easy navigation. 

 A decent amount of white space. 

 A lack of clutter. 

 Either one or two sidebars – I prefer one, on the right. 

 Easy-to-read font that is neither too large or too small. 

 Artisteer Licensing:    

 With Artisteer you have a choice of two licenses, the Home and Student version ($49.95) or the 

Standard version ($129.95). 

 Advantages of the Standard version are MANY, and include more color choices, backgrounds, 

fonts, layouts, light effects, icons, and also includes automatic color scheming, so once you 

upload your header, Artisteer will automatically generate several matching color schemes. A 

real time-saver! 

 About the Artisteer Videos 

 I’ll be covering all the settings that I, personally, use on each Amazon Minisite that I create. 

 I won’t be covering all the features of Artisteer because it would take forever! And this is an 

Amazon Minisite course, not an Artisteer course, right?  

 What I show you will give you a great start in creating your own awesome Artisteer web 

templates, or will give you ideas for customizing your preferred theme! 

9. Artisteer – Uploading Your Header 

 Header Tips 

 You *can* create your entire header in Artisteer, but I find it clunky and there are not as many 

design or font options, so I don’t use that feature. 



 Experiment with different header positions – above and separate from the sheet, attached to 

the sheet with the menu above or below, etc.  

 Try to base the color scheme of your site on your header colors, to give a very cohesive look. 

10. Artisteer – Colors and Fonts 

 Color Scheme-Standard Version 

 If you’ve got the Artisteer Standard version, it’s EASY to create a great color scheme…because 

Artisteer does it for you. LOL 

 After you upload your header, click on the Colors and Fonts tab, and click From Image. If your 

header doesn’t show up there, click the “From File” button and upload it that way, for the color 

schemes. 

 Choose a scheme from those presented. 

 Color Scheme-Home Version 

 If you’ve got the Artisteer Student/Home version, there are a lot of different color schemes you 

can choose from, and then tweak to your liking. 

 After you upload your header, click on the Colors and Fonts tab. Then, click the down arrow 

under Color Schemes. 

 Choose a scheme from those presented, and then go through and change any colors you feel 

need modifying. 

 Font Sets 

 While you certainly can choose a font set from those already set up in Artisteer, I tend to like to 

go through and just change a couple fonts within my theme.  

 Creates a more unique, personalized theme, in my opinion. 

 Remember that not all fonts will show up in all browsers.  

11. Artisteer – Background 

 Background Options 

 Artisteer’s own background options include many textures and images, as well as light effects to 

go over those textures and images. 

 Check your background color first and adjust if necessary, then choose a texture, and finally, the 

light effect, if any. 



 Play around with gradients and a fixed or scrolling background, too! 

 Choosing an Image Background 

 Many times, I’ll use an image background instead of a “stock” Artisteer texture background. 

 A full image background must be 1700x1100 pixels at the least. Buy the image at or above that 

size, because you can NOT make a photographic image bigger or it will become grainy and/or 

blurry. 

 A tileable image background can be any size. 

 Choosing an Image Background 

 Keep in mind, when using an image background, that you don’t want your site to look too 

“busy” or gaudy. Subtle images are usually best. 

 Balance the look of the header with the look of your image background to make sure you have a 

nice, clean look to your site. 

 Really bright or really busy images will not work, and rarely will you be able to use a photograph 

as a tiled background.  

 Uploading an Image Background 

 In Artisteer, click on the Background tab. 

 In Texture and Image, click “From File” and choose the image you’d like to use that you’ve 

already downloaded and saved to your hard drive. 

 Make sure you choose Position: Top Centered for a full image background, or Position: Top Left 

and Tile for a tiled image background. 

 Even if you’re using a full image background, choose a background color in Artisteer that 

matches part of it. 

12. Artisteer – Layout 

 Layout Options 

 On a very basic level, I like a simple layout that has a main content section with a sidebar on the 

right.  

 Other layout options, such as header and menu positions are completely up to you! Get 

creative! 

 The Layout tab is also where you’ll set up how your sidebar looks (just the sidebar though…not 

the blocks that make up the widgets in the sidebar). 



 Keep in Mind! 

 You already have my basic layout to use in Artisteer! The Basic Artisteer Template folder 

included with this video series give you a great jumping-off point! 

 These are just my basic guidelines, for Amazon Minisites! 

 With Artisteer, the sky’s the limit so play around and get to know it, and what it can do! 

 For inspiration, go to the Home tab, and click on Suggest Design a few dozen times! 

13. Artisteer – Sheet 

 Sheet Options 

 The sheet is the part of the web template that contains the actual content of the site, as well as 

the sidebar where any widgets will go.  

 Width – the width of the sheet will most likely be the same width as the header and will be 

fixed. 

 Margin – this is the space between the top of the sheet and whatever is above it (menu or 

header, usually). 

 Padding – this is the space between the border of the sheet and the content, sidebar, etc. 

 Sheet Options cont. 

 Radius – you can have square corners, or rounded corners 

 Fill – the color of the actual sheet itself (usually I stick with white). 

 Transparency – how “see through” the sheet color is 

 Border – thick, thin, dotted, dashed, etc. and also the color of the border. 

 Shadow – creates a 3-D look by utilizing a shadow or glow. 

14. Artisteer – Menu 

 Menu Options 

 Your menu has the power to make your site look very unique very quickly. 

 Changing the menu width, color, texture, position, gradient, as well as the menu buttons shape, 

color, border, separators, etc. can make a BIG impact on the overall look of your website. 

 Get creative with the menu to find the right look for your site – and don’t always rely on one 

basic menu look. Play around with it! 



15. Artisteer – Blocks 

 About Blocks 

 First, to clarify: blocks are where widgets will go in the sidebar of your site. You do not add these 

widgets (tag cloud, recent posts, calendar, ad banners) within Artisteer…you just make the 

“container” for them. The actual widgets are added after you install WordPress on your domain. 

 Blocks are done in Artisteer; widgets are added in WordPress. 

 Block Options 

 While your block modifications are done in the Blocks tab, you may want to go back to your 

Layout tab and look at Columns to change the actual style of your sidebar itself. Consider the 

sidebar the background for your blocks. 

 A good idea when you’re looking for more block ideas, is simply to click Suggest Blocks a few 

times until you find something that inspires you.  

 Customizing the sidebar and blocks is another easy way to make your site look very unique! 

16. Artisteer – Content 

 What is Content? 

 This is not content as in articles, this is simply the container for your content on your WP site. 

 In Artisteer, you can add content and then export that along with your template, but I typically 

don’t do that. 

 Content Options 

 By changing your content options, you will be changing how your blog posts and pages look. You 

will not be adding actual content at this point. 

 By clicking on the Shape section under Content, you can add a border that will show up around 

your articles after your template is installed in WordPress. 

 This can offset the stark whiteness of the Sheet, and by playing with shadows, different border 

styles, etc. can add a lot to your template. 

17. Artisteer – Footer 

 Footer Options 

 I usually make the footer the same color as the sheet outline, and add a gradient and/or texture. 



 The three links that are within the footer are to be used for advertising or legal links, but I’ve 

found lots of buyers don’t like them there, so you can remove them if you’d like. Or, the buyer 

can remove them in the theme settings. 

18. Choosing a Sticky Post Image 

 Sticky Post Image Guidelines 

 LICENSING MATTERS. Make sure you have correct licensing for the image you use. 

 Choose an image that has a living being in it – human, animal, baby, etc. 

 Example: If my keyword phrase is ‘container gardening’, instead of showing a container with a 

plant in it (boooooringggg), I’d choose an image of someone happily eating a tomato. Think 

outside the box, but make sure your image is still relevant to the niche you’re working in. 

 Sticky Post Image Guidelines cont. 

 For a site with an 800-900 pixel width, a horizontally-oriented image with a width of 400-500 

pixels works well. 

 After choosing and downloading your image, make any necessary edits in brightness, contrast, 

cropping, etc. and save the image using the keyword phrase as the new image name. 

 Don’t use a too-small image and try to make it bigger. It will become distorted and fuzzy, and 

won’t look right. 

 Sticky Post Image Guidelines cont. 

 You can utilize the same sites for finding images as we did for the header images: 

a. Morguefile.com 

b. Free section of Dreamstime.com 

c. Stock.XCHNG (http://www.sxc.hu/) 

19. Adding Your Domain to Your Hosting Account 

 SHARED Hosting Account 

 Make sure the DNS at your domain registrar points to your hosting account. 

 Add your domain as an add-on domain (if you’re not setting up hosting for the first time) 

 Choose a password that can not be guessed! I can’t stress how important this is. It should be at 

least ten characters in length, contain upper and lower case letters, and numbers, as well as 

special characters. 

http://www.sxc.hu/


 RESELLER Hosting Account 

 Make sure the DNS at your domain registrar points to your hosting account. 

 Create a hosting account for your domain within your reseller hosting account. The disk space 

and bandwidth do not need to be large. I typically use 100MB disk quota and 250MB monthly 

bandwidth.  

 Choose a password that can not be guessed! I can’t stress how important this is. It should be at 

least ten characters in length, contain upper and lower case letters, and numbers, as well as 

special characters. 

20. Manual Site Setup Part One 

 Disclaimer  I do not do manual site setups. I use Replikator Pro.  

 Cpanel – install WordPress. 

 Log in to WP Dashboard 

 Update WP if necessary 

 Go to Settings > Permalinks and check Custom Structure and enter this into field:  

/%postname%/ 

 Go to Posts 

 “Hello World” post – change title to your keyword phrase 

 Edit permalink to reflect keyword phrase 

 Delete post copy. Upload sticky post image. (When uploading your image, change the 

title and alt text to your keyword phrase.) Alignment > center. Link to > none. Click 

“Insert into post.” 

 Categories – add your keyword phrase as a new category and UNcheck “uncategorized”. 

 Go up to Publish in the upper right corner, and change the Visibility to Public and check 

“Stick this post to the front page”. Click OK. Click on the Publish (or Update) button. 

 Do nothing under Media or Links 

 Pages – “trash” your sample page that’s already in there 

 Appearance – go to Themes > Install Themes > Upload > Choose File (this will be the 

zipped up Wordpress theme you created) > Install Now > Activate 



 Appearance – Widgets – remove all but Search & Recent Posts in the sidebar by 

dragging the widgets you don’t want into the main content area. Then, drag from the 

main content area into the sidebar the following two widgets: Tag Cloud & Calendar 

 Save 

 Appearance – Theme Options – check “Make the header clickable”, and uncheck “Show 

headline” and “Show slogan”. Click Save Changes. 

 

21. Manual Site Setup Part Two 

 Plugins – keep Akismet, and update if necessary, but don’t activate. 

 Delete Hello Dolly plugin (answer yes to “delete these files?”) 

 Add New > Search > Contact Form 7 > Install Now > OK > Activate 

 Add New > Search > Simple Google Sitemap > Install Now > OK > Activate 

 Add New > Search > WP Insert > Install Now > OK > Activate 

 Configure plugins 

 Contact Form 7 > Settings > Click on title “Contact Form One” > click Save. 

 Copy the code in the top box. Go to Pages > Add New > name it Contact. Paste code into 

copy box. 

 Click on Screen Options in the upper right corner of your screen. Check Discussions. 

Close Screen Options. 

 Scroll down and uncheck “Allow Comments” 

 Publish page 

 Add another new page, and name it Privacy Policy. Uncheck “Allow Comments” under 

the copy box.  

 Publish page with nothing on it. 

 Go to WP Insert > Setup Legal Pages.  

 Under “Privacy Policy”, click Assign Pages > click on small blue arrow next to text field 

box > click on the + next to Privacy Policy > click green checkmark at the bottom of box > 

click Save Changes in sidebar. This sets up your Privacy Policy page. 

22. Manual Site Setup Part Three 



 Users > Your Profile > Contact Info > change email address to admin@yourdomain.com.  

 Click Update Profile (or just hit enter) 

 Settings > General > enter your keyword phrase in as Site Title and Tagline 

 Change email to “admin@” email. 

 Save Changes or hit enter. 

 Settings > Reading > Blog pages 20 > Each article in a feed to show Summary  

 Save Changes. 

23. About Replikator Pro 

 Replikator Pro is a Site Cloning Tool 

 I own and distribute Replikator Pro and have been using it for years to set up thousands of sites. 

 By utilizing Replikator Pro (or any cloning tool you may already own) you will be able to save 

yourself the immense time investment in setting up your sites manually. (Transferring the site to 

the new owner after purchase will also become far easier.) 

 Simply create a “master” blog backup file with all the basic site settings (basically everything 

except the theme) that you’ll use whenever you create a new site! 

 Purchasing Replikator Pro 

 If you would like to purchase Replikator Pro to make your site setups SO much quicker and 

easier, simply go here: 

 http://replikatorpro.com 

 Included in your Amazon Minisite MEGAProfits 2013 materials is a blog_backup.zip file I’ve given 

you that already has all the basic site settings, widgets, basic plugins, etc. already on it, just to 

make it easier for you if you do purchase RP. 

 Replikator Pro (or any cloning tool, for that matter) is totally optional. 

 I own Replikator Pro because it saves me time, and my time is money! 

 Again, this or any other cloning product is an optional time-saving tool – NOT a necessity. 

24. Replikator Pro on Shared Hosting 

 After adding  your domain to your hosting account, and changing your nameservers, stop there.  

 Do not install Fantastico or create a database! 

http://replikatorpro.com/


 If you do, Replikator Pro won’t work. 

25. Replikator Pro on Reseller Hosting 

 After creating a hosting account for your domain, and changing your nameservers, stop there.  

 Do not install Fantastico or create a database! 

 If you do, Replikator Pro won’t work. 

26. Your Minisite Listings 

 Your Own Website! 

 If you don’t already have one, you NEED a website where you will showcase and sell your 

products from. 

 I recommend using your name as your domain, with or without dashes. This way, when people 

want to know more about you, and they look up your name, it’s more likely they’ll find your 

website and buy your stuff! 

 Listing Your Minisite 

 We’ll take a look at my own website, and how I have my minisites listed.  

 Important things to highlight in your listing: 

 The main keyword phrase and it’s exact and broad search numbers 

 Any premium plugins you will be including 

 Any content you’ll be including 

 Anything that will add value in the site buyer’s eyes. 

 Please do not copy my listing copy on my listing pages.  

 Here is a screenshot of one of my listing pages: 



 



 Amazon Minisite MEGAProfits 

27. Other Places to Sell 

 Get Active, Get Noticed, Network! 

 You can’t be successful in IM unless you get yourself out there and get known! 

 Forums, Facebook, Twitter, Pinterest, Linked-In…the opportunities are endless! 

 Afraid to get out there in the IM world? You’ve got to do it!  THERE IS NO ALTERNATIVE.  

 You can’t be an internet marketer in a vacuum! 

 In IM, it’s ALL about relationships! 

 “Where do I sell my sites?” 

 Unless you have a site that already has traffic and income, don’t sell it on Flippa. Their fees have 

become far too expensive for selling minisites like these. 

 Your forum signature is a GREAT place to call attention to your main website and attract buyers, 

while creating awesome relationships. 

 List your sites for sale at places like the Warrior Forum classifieds and Forum Special Offers.  

28. Manual Site Transfer 

 After the Sale! 

 After the sale, send an email to your buyer outlining the information you need from them in 

order to transfer the site to their hosting. Here is the email I use: 

Hi there, and thank you for purchasing one of my websites! 

In order to complete the transfer of the site, I will need the following 

information: 

 your hosting cpanel url and login information (if you have a reseller account, 

please create an account for the domain <enter domain here> and send me the 

login information) 

 your nameservers 

 your Amazon affiliate ID 

 your Amazon API keys - I need both the API Access Key and the Secret Key  

 your Dynadot forum name (Dynadot is free to sign up at www.dynadot.com) 



Please provide this information at your convenience and I will get the sites 

transferred shortly! 

 After you’ve completed the site transfer, I send another email to the buyer letting them know. 

Here is the email I use: 

Hi ! 

Your site transfer is complete. I have set up an Amazon campaign for 30 posts 

set to publish one post every-other-day.  

You can log in to your WordPress admin panel using username: adminun, 

password: adminpw. Please change your password immediately for your own site 

security. 

A backup of your site has been run and sent to your email address, and further 

backups will run once a week, and they will also be sent to your email 

address. 

The domain has been pushed to your Dynadot account. 

Attached you'll find your three templates as well as a resource guide. 

If you have any questions, let me know! 

 Manual Site Transfer Cheat Sheet 

 Your cpanel: 

 File Manager - create zip file of website files and download 

 php My Admin - download correct database and export 

 Point nameservers to buyer’s hosting account. 

 Buyer's cpanel: 

 Add domain as add-on domain 

 My SQL Databases - create new database name and new user 

 Add new user to database at the bottom 

 File Manager - upload zipped file and then extract it to correct location (public_html/domain 

name) 

 Enter new database info into WP-config file & save. The place you want to find on the WP Config 

file looks like this: 



// ** MySQL settings - You can get this info from your web host ** // 

 /** The name of the database for WordPress */ 

 define('DB_NAME', 'helm_ball'); 

 /** MySQL database username */ 

 define('DB_USER', 'helm_baluser'); 

 /** MySQL database password */ 

 define('DB_PASSWORD', 'baluser2011'); 

 php My Admin - find the database you created and import database .sql file 

29. Site Transfer Using Replikator Pro 

 After the Sale -  

 Upload replikatorsingle.php file to your site files on your hosting to clone your site 

 Create blog_backup.zip file and download 

 Change nameservers to buyer’s hosting 

 Upload “destination site” files (two php files) and blog_backup.zip file 

 Run domain.com/replikatorpro.php 

30. Building Your List! 

 Your List is Gold 

 You’ve heard it before and I’ll say it again! Your list is GOLD! 

 A great way to begin building a list is to create something to give away, and use an 

autoresponder to collect the name and email of the recipient. 

 Make sure what you give away is in line with the audience you’d like to attract. 

 By doing so, you’ll create a list of buyers that are looking for what you’re selling! 

 There Are No Big Secrets! 

 The way I’ve built my list is through selling products. After purchase, my buyers have the option 

to opt-in to my list.  

 I’ve also done a few giveaways to build my list, but the majority of my subscribers have come 

directly through product sales. 



 Listbuilding doesn’t happen overnight. It’s an organic process that occurs over a period of time – 

months and even years. 

 You’ll never stop growing your list. 

 Some Listbuilding Product Ideas  

 PDF reports or guides 

 Video tutorials 

 Sets of graphics, WordPress templates, or PLR sites 

 PLR articles 

 Completed mindmaps 

 Ebooks 

 Anything that has value to the audience you want to attract! 

 Listbuilding Do’s:  

 Give the option to opt-in after purchase of a product. 

 Keep your audience engaged by sending out free content to your subscribers instead of hitting 

them with offer after offer. 

 If a listmember responds to your email, respond back at the very first opportunity. 

 Gain subscriber’s trust by offering quality products that work. 

 Listbuilding Dont’s:  

 Never, ever force an opt in, unless it’s a free product giveaway. 

 Don’t buy lists. 

 Don’t share lists. 

 Don’t continually slam your subscribers with every offer under the sun. 

 Don’t freak out over unsubscribes. 

 Think about ways you don’t like to be marketed to, and just don’t do them! 

 


